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Preface 
This manual provides a step by step process of operating and understanding the ProVAL (Profile Viewing 

and Analysis) software program.  ProVAL is an engineering software application used to view and 

analyze pavement profiles.  The analyses of interest to Mississippi DOT and paving contractor personnel 

are described in this manual.  The ProVAL software is developed by the Transtec Group through a 

contract with the US FHWA, Western Federal Lands, and the LTPP.  This software is free of charge and 

can be downloaded from the Transtec Group website (www.roadprofile.com).  Refer to the ProVAL 

Installation section of the ProVAL 3.4 User’s Guide for hardware and software requirements for this 

program.  This guide uses specific files in each example.  However, the same principles apply to any 

files being used for that individual task within the ProVAL software.  

How This Book Is Organized 
This book is divided into multiple sections that provide the user with a basic step by step guide to using 

ProVAL 3.4.  Each section explains a function of the software and how it can be used.   

The Introduction explains how to download and open the software.  It also shows information about the 

User’s Guide and various other options to help get familiar with ProVAL.  

Profile File Manipulation shows how to open a file, zoom in and out on a profile, and change units. 

The Using Editor section explains how to crop a profile and save a file.   

Smoothness Assurance (SAM) is a ProVAL analysis function that produces graphs for the MRI of a profile.  

A grinding simulation function is also included in this section. 

Quality Assurance Check is to ensure the contractor’s profiler is accurate before it is used to collect on a 

project.  This function compares the contractor’s profile of a control section to MDOT’s profile of that 

same section. 

Power Spectral Density (PSD) is a function that displays a graph of a profile’s wavelength.   There are PSD 

examples of typical pavement irregularities included in this section. 

Acknowledgments 
Milady Howard, Jordan Whittington and Matthew Strickland authored, in cooperation with the FHWA, a 

Mean Roughness Index (MRI) specification study.  This study included data collection and analysis 

recommendations for MRI. 
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Brian Schleppi of the Ohio DOT provided ProVAL examples and other information relating to MRI.  

The Transtec Group, Inc. provided the ProVAL software that is used for this project, which was funded 

by FHWA, Western Federal Lands, and LTPP.
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Introduction 
The International Roughness Index (IRI) is a statistic used to determine the amount of roughness in a 

measured longitudinal profile.  IRI values are meant to represent the ride quality experiences by 

passengers sitting in the left and right back seat.  IRI is highly correlated to vertical passenger 

acceleration.  A mathematical model is used to calculate the total vertical movement by one wheel of a 

vehicle as it travels over the pavement.  The IRI values represent the total vertical suspension travel 

divided by distance (in/mi or m/km).  An IRI value is representative of a single longitudinal profile, 

usually a wheel path of a travel lane.  Mean Roughness Index (MRI) is the average of the IRI values from 

both wheel path profiles of a travel lane, therefore producing one roughness value for the entire lane.  

Two base lengths are used to evaluate pavement smoothness.  The long interval (528 feet) is used to 

determine the overall quality and the short interval (25 feet) is used to guard against any minor 

imperfections on the pavement.   

Installing Software 
1.1 Go to the Transtec Group website (http://www.roadprofile.com/) and download the latest 

version of ProVAL. 

1.2 For hardware and software requirements, refer to page 2 of the Transtec Group User’s Guide 

which can be downloaded as displayed in section 1.4 of this document. 

1.3 Click Downloads as shown below. 

 

  

http://www.roadprofile.com/
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1.4 Click on the latest version of the ProVAL application for installation.  The Transtec Group User’s 

 Guide can be downloaded by clicking on the link just below the latest version of the application. 

 

1.5 Click Save. 
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1.6 Click Save. 

 

1.7 Once download has completed, click Run. 
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1.8 Click Next. 

 

1.9 Read the license agreement.  If you agree with it, select I accept the terms in the License 

Agreement then click Next. 
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1.10 If you do not want to install the application in the default folder, click Browse to find a location 

to install the ProVAL application. 

 

1.11 Once an installation folder is selected, click Next. 
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1.12 To create shortcuts for the ProVAL application, check the boxes next to Desktop and Start Menu 

Programs folder.  This will create a ProVAL icon on the desktop screen and add a ProVAL folder 

to the start menu.  Then click Next. 

 

1.13 Click Install to begin installation process. 
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1.14 Click Finish to complete the installation process.  If the Launch ProVAL 3.4 button is checked, the 

application will start after you click the finish button. 

 

Starting Software 
1.15 Once ProVAL is downloaded and installed, locate the ProVAL 3.4 icon on your desktop and 

double click it to open ProVAL 3.4. 

 

1.16 ProVAL opens to the starting screen and is ready for a user to open a file.  The two main sections 

on the screen are Recent Projects and ProVAL Online (if connected to web).  ProVAL Online 

displays News (updated versions of the software) and Workshops (training classes scheduled). 
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Software Help (User’s Guide) 
1.17 For a more in depth look into ProVAL 3.4, click the Help tab and select User’s Guide.  Note:  

Refer to pages 13-42 in the Transtec Group User’s Guide for help with getting started. 

 

1.18 The User’s Guide will appear on the screen in PDF format.  Note:  The Transtec Group ‘User’s 

Guide’ is not to be confused with this User’s Guide that MDOT has provided all trainees. 
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Options Tab 
1.19 Click Options in the Tools group.  This feature allows you to change default settings and import 

templates. 

 

1.20 Select ERD (.erd) from the Default File Type dropdown menu.  Contractors will submit .erd files 

to MDOT project engineers so this will be the primary file type imported into ProVAL. 
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1.21 Click Browse next to Default Project Path to create a default path for opening files.  This will 

 allow you to easily open files from a folder that contains the .erd files for all of your projects. 

 

1.22 Select the desired project folder and click OK. 
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Importing Templates 
1.23 Click the Analysis tab and select Add from File… under the Templates heading.  These templates 

are created based on the MDOT MRI specification.  There are three categories of pavement 

construction.  Each category has MRI values that the pavement’s profile must meet.  Once the 

template is imported, the user will select the correct category for the pavement being analyzed 

(see selecting template in section 4.3 on page 26).  Note:  Refer to page 63 in the Transtec Group 

User’s Guide for more information on templates. 

 

1.24 Locate the Test.pv3at template and click Open.   
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1.25 The template is imported and ready to be used when analyzing a project.  Set the Default 

 Analysis tab to Smoothness Assurance (this will be the most used ProVAL function).  
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Profile File Manipulation 

New File (Project) 
2.1 To create a ProVAL 3.4 project (.pvp file), import the appropriate .erd file.  In this example, 

double click ERD File from the ProVAL Training Folder.  The ERD File will automatically open in 

the latest version of ProVAL that is installed on your machine.   

 

2.2 Shown below is the ERD File shown after it opens in ProVAL 3.4. 
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2.3 To save the file as a ProVAL 3.4 Project (.pvp file), select Save As from the Save dropdown 

 menu. 

 

2.4 Choose a File name and folder to save the project, then click Save. 

 

2.5 Project is saved as a .pvp file (ProVAL Project).  Close the project (top left of screen) after saving. 
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Open Existing (Project) 
2.6 Click the Open button in the Getting Started group to open a file.  Note:  Refer to pages 43-50 in 

the Transtec Group User’s Guide for more information on this section. 

 

2.7 Select Start and Stop in Profile and click Open.  Note:  ProVAL 2 Projects (.pv2 files) can be 

opened using ProVAL 3.4. 

 



16 
 

2.8 File opens in default Viewer window.  Review the functions on the ribbons at the top of the 

screen to become familiar with ProVAL.  Note:  Refer to the Transtec Group User’s Guide for 

more information on each icon. 

 

2.9 To view the raw profile of the data, check the boxes next to Left Elevation and Right Elevation. 
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Zoom In on Profile 
A profile can be taken over long distances.  The user can use the zoom feature to look at a specific area 

of the profile to evaluate problems.    

2.10 The pavement’s profile will be displayed as shown below.  To zoom in on a profile section, click 

and drag across a rectangular section of the profile.  In this example, left and right elevations 

from longitudinal distance 3,300 ft to 4,900 ft. 

 

2.11 The profile should look similar to the picture below. 
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Zoom Out on Profile 
2.12 Select the Full button to return to the complete profile. 

 

Display X and Y Coordinates 
2.13 Place the cursor at a point on the graph to display its x-(distance) and y-(elevation) coordinates. 
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Change Units on Profile 
2.14 Select Units in the Display group to view unit options and select desired units. 

 

  



20 
 

Using Editor 
The Editor function is used to isolate a certain section of a pavement for roughness evaluation. 

Cropping Profile 
3.1 Select Editor in the View group.  Then, choose the desired filename from the File dropdown 

menu.  Note:  Refer to pages 52-61 in the User’s Guide for more information on editing a file. 

 

3.3 Select Sections in the Navigate dropdown menu. 
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3.3 Select Add Section in the Editor group as shown by the top arrow.  Enter “Section 1” or a name 

that appropriately describes the section in the blank and click OK. 

 

3.4 For Section 1, enter 3,000 ft as start distance and 5,000 ft as end distance.  Select Leave-Out 

 under the Type dropdown menu.  This section is now ignored in all analysis modules.  “Leave-

 Out” sections are used for bridges so that portion of the profile is not included in the analysis. 
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Save a Cropped File 
3.5 Select Save As on the ProVAL icon dropdown menu. 

 

3.6 Name the file Section 1 and select ProVAL Project (*.pvp) as the file type, then click Save. 
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3.7 Select Close Project on the ProVAL icon dropdown menu. 

 

Open Cropped File 
3.8 Select Section 1 from its saved location then click Open. 
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3.9 Select Editor from the View Group.  Choose the file Start and Stop in Profile.  Select Sections in 

the Navigate tab. 

 

View Cropped File 
3.10 View the previously created section. 

 

3.11 Close project and discard changes. 
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Smoothness Assurance  
The Smoothness Assurance (SAM) function is used to calculate and graph the short continuous interval 

and long continuous interval MRI values.   

Open File for Analysis 
4.1 Open the ProVAL Manual SAM Example file in the ProVAL Training MDOT folder.  Note:  Refer 

to pages 101-123 in the User’s Guide for more information on Smoothness Assurance and 

grinding. 
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4.2 Select the Analysis dropdown in the View group.  Then click on Smoothness Assurance. 

 

Select Appropriate Template 
4.3 Click the Template button and select Category B and then click Apply.  Note:  Refer to the MDOT 

MRI Specification for more information on pavement categories. 
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Apply 250mm Filter & Histogram Settings 
Note:  Filter & Histogram settings for each project category are included when importing templates as 

displayed in sections 1.23 & 1.24. Therefore, disregard sections 4.4 - 4.7 if template has been applied.  

4.4 Check the File box and the Apply 250mm Filter box (if necessary based on type of profiler used 

 to collect data).  Segment length should always be 25’ for short continuous, 528’ for long 

 continuous, and 528’ for fixed interval.  Next, click on Histogram next to Short Continuous.  

 Note:  Refer to pages 59-61 in the User’s Guide for more information on filtering.  

 

4.5 For the Short Continuous Histogram, change the Lower Bound (in/mi) to 0.00, the Upper Bound 

(in/mi) to 200.00, and the Class Interval (in/mi) to 5.00 then click OK.  Note:  The default Class 

Interval setting is 10.00 in/mi, but it must be 5.00 in/mi to correctly perform the pay incentive 

calculations. 
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4.6 Click on Histogram next to Long Continuous.   

 

4.7 For the Long Continuous Histogram, change the Lower Bound (in/mi) to 0.00, the Upper Bound 

(in/mi) to 120.00, and the Class Interval (in/mi) to 5.00 then click OK.  Note:  The default Class 

Interval setting is 10.00 in/mi, but it must be 5.00 in/mi to correctly perform the pay incentive 

calculations. 

 

4.8 Once the desired boxes are checked (or correct template has been applied) and the histogram 

 settings are correct, select Analyze. 
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Short Continuous Analysis 
The short continuous interval uses a base length of 25 feet to analyze a road profile and produce MRI 

values.  This short interval is necessary to guard against any sudden surprises (bumps/dips) on the 

pavement.   

4.7 To view the short continuous graph, click Short Continuous under the Navigate tab. 

 

4.8 Short Continuous graph will appear.  Areas above the allowable short continuous MRI threshold 

values are listed to the left of the graph. 
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4.9 Click on Short Continuous Histogram under the Navigate tab. 

 

4.10 Short Continuous Histogram will appear.  Numerical values are displayed to the left of the graph. 
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Long Continuous Analysis 
The long continuous interval is uses a base length of 528 feet to analyze a road profile and produce MRI 

values.  This long interval is used to set the overall quality of the pavement.   

4.11 Click on Long Continuous under the Navigate tab. 

 

4.12 Long Continuous graph will appear.  Areas above the allowable long continuous remove and 

replace MRI threshold values are listed to the left of the graph. 
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4.13 Click on Long Continuous Histogram under the Navigate tab. 

 

4.14 Long Continuous Histogram will appear.  Numerical values are displayed to the left of the graph. 
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Reporting for Smoothness Assurance  
4.15 To view data in a report format, click Report in the View group. 

 

4.16 Select the desired file format (PDF, Excel, or Text), choose a filename/folder to save report, then 

 click Select. 
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Grinding Simulation 
ProVAL has the capability to perform a grinding simulation that will help predict the post-grinding MRI 

values. 

4.17 Select Grinding under the Navigate tab. 

 

4.18 Select Auto Grind from the Analysis group.  Note:  The settings for the grinding simulation (left 

center of screen under Grinder heading) can be changed as needed. 
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4.19 The graph on the bottom of the screen highlights, in orange, the areas that grinding should 

occur.  The numerical values of the locations for grinding are displayed in a chart in the center 

portion of the screen.   

 

4.20 To apply the grinding simulation to the short continuous and long continuous MRI graphs, select 

Grind as shown below. 
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Long Continuous Grinding Comparison 

4.21 Select Long Continuous under the Navigate tab. 

 

4.22 The red line represents the long continuous MRI before grinding and the blue line represents 

the long continuous MRI after grinding.  Notice the improvement in roughness values after 

grinding.  Note: The reason that the grinding was simulated around in these three locations is 

because these areas had some bumps/dips that exceeded the short continuous threshold as seen 

in sections 4.26 - 4.29. 
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4.23 Select Long Continuous Histogram under the Navigate tab. 

 

4.24 The values for Total % Out of Spec before and after grinding are displayed below.   This shows 

the estimated values for the long continuous MRI before and after grinding the pavement’s 

rough areas. 

 



38 
 

Short Continuous Grinding Comparison 

4.25 Select Short Continuous under the Navigate tab. 

 

4.26 The red line represents the short continuous MRI before grinding and the blue line represents 

the short continuous MRI after grinding.   
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4.27 This is a zoomed in view of the 13,950 ft to 14,250 ft interval.  Notice the MRI improvement 

after the grinding simulation.  This bump/dip is now within the allowable MRI threshold. 

 

4.28 Select Short Continuous Histogram from the Navigate tab. 
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4.29 The values for Total % Out of Spec before and after grinding are displayed below.   This shows 

the estimated values for the short continuous MRI before and after grinding the pavement’s 

rough areas. 
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Quality Assurance Check 
Before a contractor profiles on a jobsite, they are required to check the accuracy of their profiler at one 

of the MDOT control sections.  The contractor must make five runs of the control section and their data 

will be compared to MDOT’s data using the Profiler Certification feature in ProVAL.  Note:  Refer to 

pages 85-88 in the User’s Guide for more information on the Quality Assurance Check. 

Processing Data 
5.1  

 

5.1 Click Profiler Certification under the Analysis tab in the View group.  Contractor’s profile runs of 

control sections will be compared to MDOT’s profile runs by using Profiler Certification function. 
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5.2 Check the box next to each run and select a basis for comparison.  In this case, the basis runs are 

from the walking profiler which tests only one wheel path at a time.  Therefore, check the Basis 

box next to each of the walking profiler runs. 

 

5.3 If data has already been filtered, the filters must be turned off.  To turn off filter, first click IRI 

(with 250mm filter) next to Basis Filter.  Note:  Ensure that the profiler does not have a filter 

built into the device before using the 250mm filter. 

 

5.4 Select None under the Filter Type tab, and then click Close.  Repeat the process for the 

Comparison Filter. 
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5.5 Once filters settings are set, click Analyze. 

 

5.6 Certification data is displayed for left and right wheel paths.  The grades (Pass or Fail) for each 

wheel path’s repeatability and accuracy are displayed at the bottom of the area boxed in red.  If 

the vendor does not pass in all columns at the bottom of the window, please contact Research 

Division and someone will investigate. 
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5.7 Select Detailed Results under the Navigate tab.  

 

5.8 A detailed result summary is displayed.   
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Reporting for Profiler Certification 
5.8 To view data in a report format, click Report in the View group then choose the desired file 

type. 

 

5.9 Choose the desired report format, provide a destination folder for the report to be saved, then 

 choose Select. 
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Pay Incentive Calculation Procedure 

Processing Data 
6.1  Enter the Smoothness Assurance Module and analyze the desired file as referenced on pages 

25-32 (must re-analyze if you have already performed a grinding simulation). After processing, 

select the Long Continuous Histogram option under the Navigate tab as referenced in sections 

4.11 to 4.14.  Again, the Histogram Class Interval must be 5.00 in/mi as referenced in sections 

4.4 to 4.6.  Once the Long Continuous Histogram is open, right click on the top row of the table 

on the left hand side of the screen and select Copy table to Clipboard.  

 

6.2 Open up the Excel spreadsheet entitled MRI Pay Incentive Template Asphalt and right click on 

the box Max MRI and select Paste.  
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Spreadsheet Inputs 
6.3 Once the table is copied into the spreadsheet, input the proper values in the boxes for Section 

Length, Surface Lift Thickness, and Unit Price. 

 

6.4 Once both of these values have been entered into the spreadsheet, you will find the section pay 

incentive value in the Incentive Pay box. 
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Power Spectral Density 

Processing Data 
6.1 Select peak in PSD in the ProVAL Training MDOT folder and click Open.  Note:  Refer to pages 

79-82 in the User’s Guide for more information on PSD. 

 

6.2 Select Power Spectral Density under the Analysis tab in the View group. 
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6.3 Check the box next to each wheel path and set filter to desired setting, then click Analyze. 

 

6.4 Displayed below is the Slope PSD (Wave Length) graph.  Notice the peak in PSD between the 5 

to 6 foot wavelength bands.   
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6.5 Click the Log Scale button to display the graph on a log scale.  Notice the same peak in PSD 

between the 5 and 6 foot wavelength band. 
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PSD Examples 

Example 1  

The figures in 6.6 and 6.7 display the PSD for pavement profiles that were collected in different 

lanes and directions on the same project.  The project consisted of an interstate mill and fill thin 

AC overlay.  In figures 6.6 and 6.7, the vibratory roller induces content into the profile by the 

amplitude and frequency settings and the rate of roller travel speed.  The bumps and dips cycle 

in and out of phase with each other between the left and right wheel paths.  This is because one 

half lane was rolled then the other half lane was rolled with the roller traveling at slightly 

different speeds.  This will cause a decrease in ride quality. 

6.6 The graph below shows that the pavement peaks in the 5 to 8 foot wavelength band.  This 

induced content is a wavelength band which affects vehicle suspensions, therefore increasing 

the MRI value.    
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6.7 The graph below shows that the pavement peaks in the 2.2 to 2.5 foot wavelength band.  This 

wavelength band is mostly outside what most effects vehicle suspensions and MRI.   

 

Example 2  

6.8 The PSD analysis shown below is for a rough road (avg. IRI = 122 in/mile).  From the peak shown 

by the arrow below, there appears to be an issue occurring in approximately 32 ft intervals. 
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Troubleshooting 
The ProVAL 3.4 program has a few known issues that can cause the software to not function properly. 

You can visit the ProVAL website (www.roadprofile.com) for help with correcting any issues.  If there are 

any further issues with the ProVAL software, contact the Research Division. 

The following two sections explain known fixes for ProVAL issues.  This information was taken directly 

from the Transtec Group’s website.   

Sending the log files 
For Windows XP (Vista may be different), your log files are located here: 

C:\Documents and Settings\[USERNAME]\Local Settings\Application Data\The Transtec Group 

For Windows 7, look here: 

C:\Users\[USERNAME]\AppData\Local\The Transtec Group 

This location is hidden so you will probably need to Show Hidden Files. Send us the Recording Log.xml 

and Event Log.xml files, preferably zipped first. It is possible these files will not exist. If this is the case, 

don't fret; just go to the next step. 

Remove potentially corrupted files 
For all files and folders listed below, we recommend moving them to a temporary location instead of 

just deleting them. If you find that one of these files is causing the problem, please send it to us so we 

can fix the problem. 

Folder: C:\Documents and Settings\[USERNAME]\Local Settings\Application Data\The Transtec 

Group\ProVAL 3.1 

Move the AutoRecovery folder (if it exists and contains files). If the software does not start, continue to 

the next step. 

Folder: C:\Documents and Settings\[USERNAME]\Application Data\The Transtec Group\ProVAL 3.1 

Move Options.xml. If PV3 does not start, then move Analysis Templates.pvat. If PV3 does not start, move 

Analysis Templates.pv3at again AND continue to the next step. 

Folder: C:\Documents and Settings\[USERNAME]\Application Data\The Transtec Group\ProVAL 3.0 

Move Options.xml. If PV3 does not start, then move Analysis Templates.pv3at. If PV3 does not start, 

move Analysis Templates.pv3at again AND continue to the next step. 

Folder: C:\Documents and Settings\[USERNAME]\Local Settings\Application Data\The Transtec 

Group\ProVAL 2.7 

Move Input Sets.xml. If PV3 does not start, contact us. 

 

http://www.roadprofile.com/
http://www.microsoft.com/windowsxp/using/helpandsupport/learnmore/tips/hiddenfiles.mspx

